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1 ABOUT THIS GUIDE
This guide provides step-by-step procedures and reference information for Receptionist Console Enterprise, 
Release 18.0.

1.1 AUDIENCE
This document is intended for end users of Receptionist Console Enterprise.

1.2 HOW THIS GUIDE IS ORGANIZED
In section 2, Receptionist Console Overview gives an overview of Receptionist Console.

The rest of this document provides a detailed description of Receptionist Console functionality.

2 RECEPTIONIST CONSOLE OVERVIEW
Receptionist Console is a carrier class Internet Protocol (IP) Telephony Attendant Console, that extends the functionality 
of your Business VoiceEdge™ solution. It is used by “front-of-house” Receptionists or telephone attendants, who screen 
inbound calls for Enterprises. The Receptionist Console realizes the promise of IP Telephony by enhancing business 
processes and delivering rich services in a user-friendly way.

Receptionist Console delivers the following real benefits to users:

 • An elegant design that is aesthetically pleasing

 • An ergonomic design that follows the natural work “flow” of a call from the top to the bottom of the screen

 • Improved business processes as only “valid” options are presented to the attendant

 • Professional call handling as critical information is available in “real time”

 • Accurate delivery of messages through a one-step process when people are unavailable

Along with this focus on design, the Receptionist Console employs the latest technology platforms and communications 
facilities.



7RECEPTIONIST CONSOLE USER GUIDE

3 LOGGING IN

3.1 WEB PORTAL LOGIN
1. Login into your Business VoiceEdge portal at https//voiceedge.comcast.com with your username and password.

2. Go to Download and click on Desktop Download.

Figure 1 - Web Portal Login

3. Download the Receptionist Client for Windows.

Figure 2 - Web Portal Login - Downloads
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4. After clicking Download, choose Open for the ReceptionistConsole.jnlp file.

Figure 3 - Web Portal Login - Open

5. The Receptionist Console application will download from respective web server.

Figure 4 - Web Portal Login - Install 
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6. When the Java dialogue box appears, click on Run to start the application.

Figure 5 - Web Portal Login - Run

7. The Receptionist Console will launch and an icon will be placed on the desktop.
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3.2 DESKTOP LOGIN
The Receptionist Console application will create a desktop shortcut on your first launch, which you can start by double-
clicking the shortcut on your desktop or by selecting it from the Start menu.

1. Click the Receptionist Console shortcut.

2. Enter your user name and password, which are the same credentials for your Business VoiceEdge Portal.

NOTE: You can also select the Remember Me (or Forget Me) and the Remember my Password options so that your user 
name and password are remembered on your computer.

3. Check Sign me in automatically to log in automatically when you click the shortcut. You also have to check  
 Remember Me and Remember my Password for automatic sign in to work.

4. Click Sign In.

Figure 6 - Receptionist Console

NOTE: If you launch Receptionist Console from a shortcut within five minutes of launching it from the web portal 
or if you have previously selected Remember Me, Remember my Password, and Sign me in automatically, you are 
automatically logged in after clicking the shortcut.
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4 RECEPTIONIST CONSOLE INTERFACE AND SETUP
This section provides a detailed description of the Receptionist Console interface. The elements that are available only 
for a specific version of the console are identified as such.

4.1 SWITCHBOARD PANEL
The Switchboard panel is located at the top of the Receptionist work area and shows all the ongoing calls.

Figure 7 - Switchboard Panel

The Switchboard panel has the following components (from left to right):
 • The Link column lets you select the calls to be linked for a Consulted Transfer and Three-Way Conference. 
  To link calls, click in their Link column cell.

  The appearance of a chain link symbol  indicates the activation of this option. Clicking in the cell toggles 
  the link option again.

 • The Line column shows the order that phone calls come in, starting from 1.

 • The Call To (Called Party) column identifies the party being called by you. A name is typically displayed when 
  the called party is in the Contact directory. A number is displayed for calls to persons not in the Contact  
  directory and most external calls.

 • The Call From (Calling Party) column identifies the person calling you. For internal calls, this is the name  
  assigned to the extension number in the Contact directory or the extension number, if no name has been  
  assigned. For external calls, it is the caller’s number unless the number is blocked (private) or the name  
  is unavailable.

 • The Status column shows the state of calls on the operator switchboard (phone) and is color-coded as follows:

Call State Display Status

Active Active

Held On Hold (00:00) (blinks after 45 seconds)

Camp On Camped (00:00) (blinks after 45 seconds)

Remote Held Active

Ringing In (Remote) Incoming

Ringing In (Local) Incoming

Ringing Out Outgoing

 • The Time column displays the duration of the call, including the Ring Time, Hold Time, and Talk Time.
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4.2 CONTACT DIRECTORY PANEL
The Contact Directory panel is located as the third panel of the main interface and provides a listing of all contacts 
available to the operator.

Figure 8 - Contact Directory Panel

4�2�1 Capabilities

You are provided with the following capabilities:

 • Contact information

 • Convenient access to contact extension numbers and voice mail

 • Ability to view contact status

 • Ability to search contacts

 • Ability to add, delete, and edit speed dial contacts

 • Call Management



13RECEPTIONIST CONSOLE USER GUIDE

4�2�2 Directory Management Interface

At the bottom of the Contact Directory panel, there are several dialog boxes and buttons that assist you 
in managing directories:

 

Figure 9 - Contact Directory – Directory Management Interface

 • The Search text box  allows you to enter a string you want to use to search for contacts, typically a  
  contact’s name or phone number or part thereof. The search returns all contacts containing the string as part  
  of the selected directory field. For example, entering “Ann” and selecting “First Name” from the Search Filter  
  Category returns all contacts with the first name “Ann”, but it also returns all contacts with first names such as  
  “Anne”, “Marianne”, “Marie Ann”, “Ann Marie”, and so on.

NOTE: The search is NOT case sensitive; searching for “Ann” or “ann” returns the same results.

 • The Search Filter Category drop-down list  allows the operator to choose a directory field for a 
  keyword search. The value selected from this filter drop-down list is the column in which the tool searches  
  for the string entered in the Search text box, as well as the directory.

 • The Search button  , when clicked, enacts a keyword search based on the keyword and the Search fields.

 • The Reset button  , when clicked, displays the full list of contacts, removing the effects of previous 
  searches and filters.

 • The Add button  allows you to add an entry to the Speed Dials directory. It is only enabled when the  
  Speed Dial directory is selected in the Contact Directory panel.

 • The Delete button  lets you remove the entry currently selected in the Contact Directory panel.  
  This button is only enabled for the Speed Dial directory.

For information about managing directories, see section 7 Managing Directories.
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4.3 DIRECTORIES
The directory tabs at the top of the Contact Directory panel allow you to choose the directory you want to appear 
in the panel.

Figure 10 - Directory Heading Tabs

Table 4 lists the directories available for the Receptionist Console.

Directory Name Contents Enterprise Small Business Office

Comcast Business 
VoiceEdge 
Contact Directory

Other subscribers in 
your Comcast Business 
VoiceEdge contact directory

 


Group Only

Comcast Business 
VoiceEdge 
Personal Directory

All contacts in your Personal 
Phone List on the Comcast 
Business VoiceEdge portal

  

Speed Dials 
Directory

All numbers configured 
for you or by you for your 
Speed Dial service

  

Phone Status 
Monitoring

A list of users, configured 
through the web portal, 
whose phone status you 
are currently monitoring


(Monitoring limited to 
200 static and up to 
800 dynamic users 

enterprise-wide)


(Monitoring limited 

to 30 users company-
wide)


(Monitoring 

limited 
to eight users 
group-wide)

LDAP Directory

All users found in the LDAP 
directory. The directory 
needs to be configured by 
your system administrator. 
Otherwise, it is not visible.



Custom Contact 
Directories

Created and customized by 
the administrator or via the 
search tool



Outlook Directory

All your Outlook contacts. 
The directory needs to be 
enabled via the Tools – 
Options tab.



Table 4 - Receptionist Directories

To show or hide directories tabs in the Contact Directory panel, select View and then Directories from the menu bar, 
and then select or deselect directory names.

Changes to the users to monitor lists, Personal Contacts Lists, and Speed Dial lists are made through the web portal 
and are only visible in the console the next time you sign in. 
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4�3�1 Contact Status Information

The Call Status icon, available in some directories, in both List and Details view, shows the contact’s phone on-hook/
off-hook state. The color of the icon is customizable through the Tools – Options – Themes dialog box. The following 
colors represent the default definitions:

Call Status Icon Description

Available Contact phone is on-hook (available to receive a call).

Busy Contact phone is off-hook (on a call, busy).

Ringing Contact phone is ringing (previously this was a blue triangle).

Do Not Disturb Contact phone has status set to “DND”.

Unavailable Contact phone state is currently unavailable or unknown.

Private Contact phone state is set to “private”.

Call Forwarding Always
Contact has the Call Forwarding Always service turned on. By hovering 
your mouse over the Call Forwarding Always contact, you can see the 
number the contact has set the Call Forwarding Always to.

Figure 11 - Call Status Legend

4�3�2 Views

The Receptionist Console has two types of directory views, providing different levels of contact information detail.

 • All versions of the console are equipped with the List view of their directories.

List View

The List view lists all the contacts in the selected directory.

 

Figure 12 - Contact Directory Panel – List View

Additionally, for some directories, such as Contact Directory and Monitored Contacts, the contact’s call status is 
provided.
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4.5 OPTIONS PANEL
The Options panel is located as the fourth panel of the main interface. When the Receptionist Console interface is 
resized (full screen or otherwise), the Options panel size remains unchanged. This allows for the Contact Directory 
panel to display a maximum number of contacts. However, the size can be changed manually.

Figure 13 - Options Panel

The Options panel is used to select call managing options and has the following components:

 • The Extn button allows you to transfer a call or make a call to the selected contact’s extension. If this icon  
  is grayed out, the contact does not have an extension number associated with the contact’s name in the  
  Contact Directory. Only the group/system administrator can modify this number.

 • The Phone button allows you to transfer a call or make a call to the selected contact’s phone number. It is  
  assigned to the same button as Extn and becomes visible when calling a phone number. Only the group/ 
  system administrator can modify this number.

 • The Mobile button allows you to transfer a call or make a call to the selected contact’s mobile phone. If this  
  icon is grayed out, the contact does not have a mobile number associated with the contact’s name in the  
  computer database. Only the group/system administrator can modify this number.

 • The Voicemail button allows you to transfer a call to the selected contact’s voice mail. 
  If this icon is dull in appearance, the contact does not have voice mail configured. Only the group/system  
  administrator can modify this number.

 • The Other button, when clicked, displays a dial pad used to enter an ad hoc number. 
  It allows you to transfer a call or make a call to another number.

NOTE: The look of the buttons on the Options panel changes as they become available or unavailable. If an option  
is available in a given context or operation, the corresponding button is active (colorful); otherwise, it is grayed out  
or invisible.
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4.6 CONTROL PANEL
The Control panel is used to execute call actions. Call actions can also be performed by clicking Actions on the Menu 
bar and selecting the desired function. When the Receptionist Console interface is resized (full screen or otherwise), 
the Control panel size remains unchanged. This allows for the Contact Directory panel to display a maximum number of 
contacts. However, the size can be changed manually.

Figure 14 - Control Panel

NOTE: The look of the buttons on the Control panel changes as call actions become available or unavailable. Several 
actions can be assigned to the same button. When an action is active, the button changes to reflect that function. When 
no action assigned to the button is active, the button is grayed out.

The Control panel is used to execute call actions, and contains the following components, grouped by display button:

 • Dial button group:

  - The Dial button is used to start the dialing process to the number you have selected. You can make a call  
   to a contact when a contact is highlighted and you can make a call to another number when the dial pad  
   has been used. This button is dull in appearance when this action is not an option.

  - The Send button is used to send messages. When messaging, the Dial button changes to Send.

 • Answer button group allows you to perform a variety of functions depending on the context of the active call. 
  The following dynamics change the button based on the call context:

  - The Answer button is enabled for incoming calls and allows you to answer a call.

  - The Hold Conference button is enabled when the selected call is in a conference and allows you to put  
   the call on hold.

  - The Unhold Conference button is enabled when a conference is on hold and allows you to return it to the  
   Active state.

  - The Hold button is enabled when a call is active and allows you to put it on hold.

  - The Unhold button is enabled when a call is on hold and allows you to unhold it.

 • Transfer button group allows you to perform a variety of functions depending on the context of the active call.  
  The following dynamics change the button based on the call context:

  - The Blind Transfer button is enabled when the selected contact is in the Available call state.

  - The Voicemail button is enabled when the contact selected is in the Available call state.

  - The Consulted Transfer button is enabled when two call parties are linked on the switchboard.

  - The Leave Conference button is enabled when a conference is in an Active state and you want to exit it.

 • The Conference button group allows you to perform a variety of control functions, depending on the context of  
  the active call. The following dynamics change the button based on the call context:

  - The Conference button is enabled when two call parties are linked on the switchboard and allows you to  
   start a conference call.

  - The End Conference button is enabled when a conference is active and allows you to end the  
   conference call.

  - The Call Pick-Up button is enabled when the contact selected is in a Ringing Call state.

  - The Call Barge-in button is enabled when the selected contact is in a Busy Call state and allows you to  
   barge in on the call.

 • The End button allows you to disconnect the selected call.

For more information on call management functions, see section 6 Managing Calls.
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5 MENU BAR
The Menu bar is located at the top of the console’s main page. It has the following menu items, described in the 
following sections: File, View, Actions, Tools, and Help.

5.1 FILE MENU
The File menu allows you to sign out or exit the Receptionist Console.

Figure 15 - Receptionist File Menu

The File menu items are as follows:

 • Sign Out signs you out of the console and displays the Login menu so that you can login again  
  (possibly as a different user).
 • Exit signs you out and exits Receptionist.

5.2 VIEW MENU
The View menu allows you to select which information you want to be visible in the Receptionist Console.

Figure 16 - Receptionist Console View

The View menu items are as follows:

 • The Directories item allows you to select which directories you want to be visible in Receptionist. The selected  
  directories are displayed as tabs at the top of the Contact Directory panel.

NOTE: Directories listed on this menu depend on your version of Receptionist Console and your setup.
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5.3 ACTIONS MENU
The Actions menu lists all the phone management actions of the console. Only actions applicable at any given moment 
are active. All other menu items are grayed out.

Figure 17 - Receptionist Console Actions Menu

The use of actions is explained in context in the appropriate subsections in section 6 Managing Calls.

5.4 TOOLS MENU
The Tools menu contains various tools that help you set up and manage the console.

Figure 18 - Receptionist Console Tools Menu

The tools are Call History and Options. They are described in the following sections.
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5�4�1 Tools – Call History

The Call History dialog box is used to view and delete the user’s call logs. The dialog box can be displayed from 
the Menu bar by selecting Tools – Call History.

Figure 19 - Tools – Call History

The following sections describe all the tabs, with those available only in some versions of the Receptionist Console 
clearly identified.
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Dialed Calls Tab

To see dialed calls, click the Dialed Calls tab.

Figure 20 - Call History – Dialed Options

The records contain the following information:

 • Name is the name of the call recipient for internal numbers (where available from the company directory).  
  It can also be the number of the call recipient for external numbers or for internal numbers when no name  
  is available.

 • Number is the number of the call recipient.

 • Time is the time of the call.
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Received Calls Tab

To see received calls, click the Received Calls tab.

Figure 21 - Call History – Received Calls

The records contain the following information:

 • Name is the name of the caller for internal numbers (where available from the company directory). It can also 
  be the number of the caller for external numbers or for internal numbers when no name is available.

 • Number is the number of the caller.

 • Time is the time of the call.
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Missed Calls Tab

To see missed calls, click the Missed Calls tab in the Calls History dialog box.

Figure 22 - Call History – Missed Calls

The records contain the following information:

 • Name is the name of the caller for internal numbers (where available from the company director). It can also 
  be the number of the caller for external numbers or for internal numbers when no name is available.

 • Number is the number of the caller.

 • Time is the time of the call.
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Delete Call History Logs

You can delete one entry, multiple entries, or all entries in the Call History tab. To delete the call logs, do the following:

1. Select the call entry by clicking on it with the mouse or holding down TAB and using the arrow keys. For selecting  
 consecutive entries, hold down SHIFT while selecting the calls. If you want to select multiple calls that are not  
 together, hold down CTRL and select the desired calls. To select all the calls in the open dialog, whether that  
 includes the dialed, received, or missed calls, click Select All.

Figure 23 - Select All Button

Alternatively, if you want to delete all of the call history entries, click the Clear All button.

Figure 24 - Clear All Button

2. A warning message asks for your confirmation. Select Yes.

Figure 25 - Call History Confirmation Message

The entries are now cleared.

NOTE: This functionality is only available if you have been assigned this feature by your system administrator. If you do 
not have sufficient permission to perform this action, a service error message informs you of this.
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5�4�2 Tools – Options

The Tools dialog box is used to configure user/service provider settings and preferences. The dialog box can be 
displayed from the Menu bar by selecting Tools and then Options. It is available on both the login and main interface 
pages.

Figure 26 - Tools – Options

The dialog box in Figure 26 displays all Receptionist Console options. The following sections describe all the options, 
with options available only to some versions of the Receptionist clearly identified.
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General Tab

The General tab contains miscellaneous features that improve the usability of the Receptionist Console.

Figure 27 - Options – General

The General Options are as follows:

 • Auto login when connected to network enables Receptionist to automatically try to re- connect and log in to  
  the server after you lose your network connection.

The Alerts are as follows:

 • Auto switch focus on incoming call enables Receptionist to automatically take window focus over other  
  applications when a new incoming call is received.

The Language options are as follows:

 • The Language drop-down list allows the option of changing the language from the default English (U.S.). 
  The language options are:

  - English (U.S.)

  - French (France)

  - German (Germany)

  - Italian (Italy)

  - Spanish (Spain)

  - Spanish (CALA), for Central and Latin America

  - Simplified Chinese (PRC), for People’s Republic of China

  - Any custom language the administrator has specified

Selecting the desired language, click OK and restart the console for the changes to take place.

 • Synchronize language with service profile, when checked, enables Receptionist Console to automatically  
  match the application language to the language set within the Business VoiceEdge Portal account settings 
  after signing in.

NOTE: If no profile match is found, the language remains set to the current language
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Directories Tab

Click on the Directories tab to configure which directory is visible on startup of Receptionist.

Figure 28 - Options – Directories

The Directory Options allows you to select the directory you want to appear in the Contact Directory panel 
at startup.

Click on the Start-Up Directory drop-down list to select the “Last viewed” directory or any other directory 
available to you.

5.5 HELP MENU
The Help menu contains the following items:
 • User Guide – A link to a PDF version of this guide.

 • About Receptionist IHS – The same information as the Tools – Options About tab.

Figure 29 - Receptionist – Help Menu
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6 MANAGING CALLS
You manage calls using a combination of the panels in a top to bottom workflow style. You should be able to distribute 
calls typically using this workflow for most of the activities in the following subsections.

The following subsections describe the call management functions available in the console. Functions available only in 
certain versions of Receptionist Console are identified as such.

6.1 DIALING
Dialing allows you to make calls to contacts in a variety of ways.

6�1�1 Dial Contact

To make a call to a contact:

1. Find and select the contact you want to call by searching the Contact Directory or any other directory where  
 the contact may be listed.

Figure 30 - Contact Directory Panel

2. In the Options panel, select the option you want to use for this contact. Possible options include the extension,  
 mobile, or voice mail. In most cases, an option (usually the contact’s extension) is selected by default. To change  
 the selected option, simply click another option once. Unavailable options are dull in appearance.

3. In the Control panel, click Dial. Alternatively, click Actions on the Menu bar, and select Dial from the drop-down list.

Figure 31 - Dial Button

NOTE: The contact’s extension is dialed in preference to the number field when both are populated. If there is no 
extension field provided, Receptionist attempts to dial using the number field.

The called party phone rings, and the call appears on the Switchboard panel as “Outgoing”. When the call is answered 
by the destination number, the call is connected and you talk to the contact at that number.

NOTE: Alternatively, you can double-click a contact to dial the contact’s default call option (automatically selects 
extension, mobile, voice mail, in order of availability).
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6�1�2 Dial Ad Hoc Number

To make a call to an ad hoc number (a person not listed in your Contact Directory):

1. In the Options panel, click Other. The dial pad appears

Figure 32 - Other Button

2. Enter the number you want to call either by typing the number on the keyboard or by selecting each number in 
 turn from the dial pad using your mouse.

3. Click the Dial button on the Control panel. Alternatively, click Actions on the Menu bar, and select Dial from the  
 drop-down list.

Figure 33 - Dial Button

The called party phone rings, and the call appears on the Switchboard panel as “Outgoing”. When the call is answered 
by the destination number, the call is connected and you talk to the contact at that number.
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6�1�3 Dial from Call History

You can initiate a call from Call History, by clicking a phone number in one of the call logs. To dial from Call History:

1. From the Menu bar, select Tools and then Call History.

2. Select the Call History page you want (Dialed Calls, Received Calls, or Missed Calls).

When you move the cursor over a telephone number in a call list, the number becomes underlined to indicate that it is 
a hyperlink that can be clicked.

Figure 34 - Dialing From Call History

3. Click the phone number you want to call.

The called party’s phone rings, and the call appears on the Switchboard panel as “Outgoing”. When the call is 
answered by the destination number, the call is connected and you talk to the contact at that number.

Figure 35 - Switchboard Panel – Dialed Call
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6.2 ANSWER CALL
NOTE: You must have a phone from the supported phone’s list; otherwise, undesirable behavior may occur. For further 
information, contact your service provider.

To answer a call:

1. Select the call you want to answer from the Switchboard panel.

Figure 36 - Switchboard Panel – Incoming Call

2. In the Control panel, click Answer. Alternatively, click Actions on the Menu bar, and select Answer from the 
 drop-down list.

Figure 37 - Answer Button

NOTE: You can answer the longest waiting incoming call by clicking the space bar key. Consecutive presses of the 
space bar place the previous active call on hold and answer the oldest incoming call. This does not work if you are 
clicking on a text field.

6.3 PUT CALL ON HOLD
You put call on hold using the Hold button. The call must be already in progress.

6�3�1 Hold Call

To place a call on hold:

1. Select the call you want to put on hold from the Switchboard panel.

Figure 38 - Switchboard Panel – Active Call

2. Click Hold on the Control panel to hold the call. Alternatively, click Actions on the Menu bar, and select  
 Hold from the drop-down list.

Figure 39 - Hold Button

The call status changes to “On Hold”.
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6�3�2 Unhold Call

To take a call off hold:

1. Select the call you want to take off hold from the Switchboard panel.

Figure 40 - Switchboard Panel – Held Call

2. Click Unhold on the Control panel. Alternatively, click Actions on the Menu bar, and select Unhold from the 
 drop-down list.

Figure 41 - Unhold Button

The call becomes active and the call status on the Switchboard panel changes from “On Hold” to “Active”.

NOTE: Alternatively, double-click on the held call on the Switchboard panel.

6.4 END CALL
To end a call:

1. Select the call you want to end from the Switchboard panel.

Figure 42 - Switchboard Panel – Active Call

2. Disconnect the calling party by clicking End on the Control panel. Alternatively, click Actions on the Menu bar, 
 and select End from the drop-down list.

Figure 43 - End Button

The calling party is disconnected when the End button is clicked.

NOTE: When you end an incoming call before the call has been answered, the caller continues to hear the ringing tone 
until the caller hangs up.
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6.5 TRANSFERRING CALLS
There are a number of ways in which you can transfer a call to another contact.

6�5�1 Blind/Cold Transfer Call

A blind or cold transfer occurs when a call is transferred without an introduction. Calls may be blind transferred while 
active, held, or ringing (in) on your phone. If a call is ringing (in), the blind transfer activity allows the call to be redirected 
before it is answered. This can be done via “drag and drop” or through the Control panel.

To conduct a blind transfer using drag and drop:

1. Click the call you want to transfer from the Switchboard panel with your left mouse button. Your cursor changes to 
 a handgrip to indicate the call is moveable.

Figure 44 - Hand Grip Cursor

2. To scroll up or down a list, move the cursor over the corresponding corner of the contact directory. To cancel 
 the move at any time, press Esc.

3. Drag the call to the target contact in your Contact Directory or Customized Directory, and let go of the left 
 mouse button. The call is now transferred. If the target contact is busy, the call is camped.

To conduct a blind transfer:

1. Select the call you want to transfer from the Switchboard panel.

2. Select the option to which you want to blind transfer the call. This number may be the option for a contact from 
 the Contact Directory, a speed dial, or another number of your choice entered using the Other dial pad.

3. Click Blind Transfer highlighted on the Control panel. If the Blind Transfer button is not highlighted, click  
 Actions on the Menu bar, and then select Blind Transfer.

Figure 45 - Blind Transfer Button

The call is now transferred and then removed from the Switchboard panel.

6�5�2 Conduct Supervised Transfer

When you have an active inbound call that you want to transfer to another contact, do the following:

1. Make sure that the first call is answered and active.

2. Dial the number you want to transfer the call over to.

3. Click the Consulted Transfer button on the Control panel to conduct the transfer. If the Consulted Transfer button 
 is not highlighted, click Actions on the Menu bar, and then select Consulted Transfer.

Figure 46 - Consulted Transfer Button

NOTE: If the dialed contact is busy, you can retry or dial another contact. The call is transferred to the first available 
dialed contact.
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6�5�3 Conduct Warm/Consulted Transfer

A warm or consulted transfer allows the operator to announce or introduce the call to the called party. A call may be 
warm transferred while active, held, or ringing (out).

To conduct a warm transfer:

1. Dial the contact you want to transfer the call to.

2. When the call is connected, consult with the called contact.

3. Link the two calls to be connected together by clicking in the Link column on the Switchboard panel. You must 
 do this for both calls, thereby identifying the calls to link.

Figure 47 - Switchboard Panel – Linked Calls

4. To transfer the calls, click Consulted Transfer highlighted on the Control panel. Alternatively, click Actions 
 on the Menu bar, and select Consulted Transfer from the drop-down list.

Figure 48 - Consulted Transfer Button

The call is now transferred and both calls are removed from the Switchboard panel.

NOTE: If you have an active call and place another call, these two callers are automatically linked on the  
Switchboard panel.

6�5�4 Transfer to Voice Mail

To transfer a call to voice mail:

1. Select the call you want to transfer from the Switchboard panel.

Figure 49 - Switchboard Panel

2. From the Contact Directory, select the name of the contact with voice mail where you want to transfer the call.  
 Select yourself if you want to transfer the call to your voice mail.

NOTE: This option is only available if the contact to whose voice mail you would like to transfer the call has the Voice 
Messaging service assigned and enabled. Otherwise, the Voicemail option is grayed out.

3. On the Options panel, click Voicemail.
4. Transfer the call to the contact’s voice mail by clicking Voicemail Transfer on the Control panel. Alternatively, 
 click Actions on the Menu bar, and select Voicemail Transfer from the drop-down list.

Figure 50 - Voice Mail Button
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6.6 CONDUCT DIRECTED CALL PICKUP
Directed Call Pickup allows the operator to pick up a call that is incoming on a contact. This is useful when you want 
to answer a call on the contact’s behalf or if the contact is currently not on hand to answer the call. This functionality is 
only available if you have been assigned this service by your group/system administrator. Depending on your setup, 
you can conduct directed call pickup for users in your group or for users in the entire enterprise.

To conduct a Directed Call Pickup:

1. Select a contact who you want to pick up the call for. The contact’s status must be “Ringing”.

2. Click Call Pick-Up highlighted on the Control panel. Alternatively, click Actions on the Menu bar, and select 
 Call Pick-Up from the drop-down list.

Figure 51 - Call Pick-Up Button

3. You answer the call on the contact’s behalf and the Switchboard panel shows a new “Active” line representing 
 this call.

6.7 BARGE-IN ON A CALL
Call Barge-in allows you to barge in on a contact’s call. This is useful when you want to enter an already established 
call between two other people. This functionality is only available if you have been assigned this service by your group/ 
system administrator. Depending on your setup, you can barge in on contacts in your group or enterprise.

To conduct a call barge-in:

1. Select a contact who you want to pick up the call for. The contact’s status must be “Ringing”.

2. Click Call Pick-Up highlighted on the Control panel. Alternatively, click Actions on the Menu bar, and select 
 Call Pick-Up from the drop-down list.

Figure 52 - Call Barge-in Button

3. You answer the call on the contact’s behalf and the Switchboard panel shows a new “Active” line representing 
 this call.

You enter an ongoing call, thereby establishing a Three-Way Conference.

6.8 MANAGING CONFERENCE CALLS
Click Conference so you are allowed to participate in Three-Way Conference calls. The button is dull in  
appearance when this action is not an option. Alternatively, click Actions on the Menu bar, and select Conference 
from the drop-down list.

Figure 53 - Conference Button
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6�8�1 Start Conference Call

To start a conference:

1. Select the calls. Choose both parties with whom you want to conduct a conference from the Switchboard panel.

2. Link the two calls by clicking on both their “LINK” entries. One chain link should appear in each respective entry.

Figure 54 - Switchboard Panel – Linked Calls

3. On the Control panel, click Conference. Alternatively, click Actions on the Menu bar, and select Conference  
 from the drop-down list.

Figure 55 - Conference Button

Both calls become Active.

6�8�2 Hold Conference Call

To hold an active conference, click Hold Conference on the Control panel. Alternatively, click Actions on the Menu bar, 
and select Hold Conference from the drop- down list.

Figure 56 - Hold Conference Button

Figure 57 - Held Conference Switchboard Panel

The conference link icon changes when this button is pressed. The conference is held.

Figure 58 - Switchboard Panel – Active Conference
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6�8�3 Unhold Conference Call

To reactivate a held conference:

When a conference is held, the call status for the parties involved shows On Hold.

Figure 59 - Unhold Conference Button

Click Unhold Conference on the Control panel. Alternatively, click Actions on the Menu bar, and select Unhold 
Conference from the drop-down list. Both call states change to Active when the action is complete.

Figure 60 - Switchboard Panel – Active Conference

The conference link icon changes when this button is pressed. The conference is held.

6�8�4 Leave Conference Call

To exit from a conference, click Leave Conference on the Control panel. Alternatively, click Actions on the Menu 
bar, and select Leave Conference from the drop- down list.

Figure 61 - Leave Conference button

This removes the user from the conference call although the two other parties involved in the conference call are still 
connected. The two parties are removed from the Switchboard panel.

6�8�5 End Conference Call

To end a conference call, click End Conference on the Control panel. Alternatively, click Actions on the Menu bar, and 
select End Conference from the drop-down list.

Figure 62 - End Conference Button

The calls are removed from the Switchboard panel and terminated.
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7 MANAGING DIRECTORIES
The Contact Directory panel in Receptionist Console allows you to view, search, and edit a variety of different types 
of directories.

The Status column of the Contact Directory and any custom contact directory shows the contact’s phone on-hook/
off-hook state. The color of the state is customizable through the Tools – Options – Themes dialog box. The following 
colors represent the different automated states:

Status Icon Description

Green Handset Down
Contact phone is on-hook (available to receive a call)  
(previously this was a green triangle).

Red Handset Up Contact phone is off-hook (on a call, busy).

Orange Handset Down Contact phone is ringing (previously this was a blue triangle).

Do Not Disturb
Contact phone has status set to “DND”
(previously this was an orange triangle).

Grey Handset Down
Contact phone state is currently unavailable or unknown 
(previously there was no triangle or it was blank).

Private Contact phone state is set to “private”.

Call Forwarding Always
Contact has the Call Forwarding Always service turned on. 
By moving your mouse over the contact, the user can see the 
phone number the contact has set the Call For-ward to.

7.1 VIEW DIRECTORY
To view a directory, click View in the Menu bar.

From the Directories drop-down list, check the directory you want visible. This includes custom contact directories.

7.2 HIDE DIRECTORY
To hide a directory, click View in the Menu bar.

From the Directories drop-down list, uncheck the directory you want invisible. Alternatively, click the x on the 
Directory tab.

7.3 SELECT DIRECTORY
Use the Contact Directory tab list to select the directory displayed in the Contact Directory panel.

Figure 63 - Directory Heading Tabs
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7.4 SEARCH DIRECTORY
You can search a directory using the search feature located at the bottom left of the Contact Directory panel.

Figure 64 - Search Directory

To search a directory:

1. Click the target directory tab at the top of the Contact Directory panel.

2. Enter a keyword (or part of a keyword) in the Search text box at the bottom left of the Contact Directory panel.

NOTE: The keyword search is NOT case sensitive; the search for “Ann” or “ann” returns the same results.

3. Select a category (directory field) from the Search Filter Category drop-down list. The available categories depend  
 on the directory you are searching. The default value is “All”.

4. Click Search.

The results of the search appear in the Contact Directory panel.

Depending on your setup, the Receptionist Console returns either all the contacts (in the Contact Directory), which 
contain the entered keyword as any part of the selected filter (directory columns) or all the contacts that start with the 
entered keyword.

 - In the first case (Contains), entering “Ann” and selecting “First Name” from the Keyword Search Filter  
  drop-down list returns all contacts with the first name “Ann”, but it also returns all contacts with first names such  
  as “Anne”, “Marianne”, “Marie Ann”, “Ann Marie”, and so on.
 - In the second case (Starts With), entering “Ann” and selecting “First Name” returns all contact with the first  
  names such as “Ann”, Anne”, and Ann Marie”, but not “Marianne” or “Mary Ann”.

5. To return to the full directory, click Reset.

NOTE: You can narrow down your search, applying another search to the results of a previous search.

The results of the search appear in the Contact Directory panel and the definition of this search is appended to the 
name of the directory on the selected directory tab. 
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7.5 MANAGE SPEED DIAL ENTRIES
There are two types of speed dial entries: Speed Dial 8 and Speed Dial 100.

 • Speed Dial 8� With Speed Dial 8, Receptionist provides eight predefined empty slots, numbered 2 through 9. 
  Speed Dial 8 entries cannot be added or deleted; they can only be edited. You can assign dialing information  
  to a Speed Dial 8 entry, and change or delete dialing information by editing the corresponding slot.

 • Speed Dial 100� With Speed Dial 100, you can add up to 100 entries. You can also modify or delete existing 
  Speed Dial 100 entries.

7�5�1 Edit Speed Dial 8 Entry

You can assign, modify, or remove dialing information from a Speed Dial 8 entry using the Edit  button, located at the 
bottom right-hand corner of the Contact Directory panel.

Assign Dialing Information to Speed Dial 8 Slot

1. In the Speed Dials directory, select an empty Speed Dial 8 slot.

2. Click Edit.

Figure 65 - Assign Dialing Information to Speed Dial 8 Slot

3. In the dialog box that appears, enter the phone number and description.

4. To save the entry, click OK. Click Cancel to exit without saving your changes.

Modify or Delete Assigned Speed Dial 8 Entry

1. In the Speed Dials directory, select an assigned Speed Dial 8 slot.

2. Click Edit.

Receptionist opens a dialog box in which you can edit the information.

Figure 66 - Speed Dial 8 Entry

3. Modify or delete information as desired. Note, however, that you cannot delete the phone number and leave the  
 description. If you try to do that, an error message appears.

4. To save the entry, click OK. Click Cancel to exit without saving your changes.
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7�5�2 Add Speed Dial 100 Entry

You add a Speed Dial 100 entry using the Add button  located at the bottom right-hand corner of the Contact 
Directory panel.

1. Select the Speed Dials Directory tab.

2. Click Add.

Receptionist Console opens a window in which you enter the information.

Figure 67 - Add Speed Dial Dialog Box

3. Select a key value from the drop-down list. The key value determines what numbers you have to press on 
 your phone to dial this Speed Dial entry.

4. Enter the phone and description.

5. To save the new entry, click OK. Click Cancel to exit without creating the new entry.

7�5�3 Edit Speed Dial 100 Entry

You can edit an existing Speed Dial 100 entry using the Edit button  located at the bottom right-hand corner of the 
Contact Directory panel.

1. Select the Speed Dials Directory tab.

2. Click the desired Speed Dial 100 entry.

3. Click Edit.

Receptionist Console opens a dialog box in which you can modify the information.

Figure 68 - Edit Speed Dial Dialog Box

4. Change the displayed values as desired.

5. To save the entry, click OK. Click Cancel to exit without saving your changes.
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7�5�4 Delete Speed Dial 100 Entry

You can delete an existing Speed Dial 100 entry using the Delete button  located at the bottom right-hand corner of 
the Contact Directory panel.

1. Select the Speed Dials Directory tab.

2. Click the desired Speed Dial 100 entry.

3. Click Delete.

4. Click Yes to confirm your action.

Figure 69 - Confirmation Dialog Box
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8 GLOSSARY
Name Description

Active Call This is the call you are currently talking to or dealing with.

Ringing (In) This is the equivalent to a phone ringing locally.

Calling Party This is the party who you are receiving a call from.

Called Party This is the party that you have dialed.

Music on Hold This is music that is streaming from the service provider for a held call.

Ringing (Out) This is equivalent to a phone ringing on the called party’s phone.
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9 KEYBOARD SHORTCUTS
The following is a listing of keystrokes (shortcut keyboard entries) that are available in the Receptionist Console.

9.1 GENERAL CONTROL KEYS

Key Strokes Equivalent Mouse Action Function

ESCAPE Click OK/CANCEL/EXIT. Exits from the active window.

9.2 MENU BAR CONTROL KEYS

Key Strokes Equivalent Mouse Action Function

Alt + O Click Tools and then Options. Displays Options dialog box.

Alt + R Click Tools and then Call History. Displays Call History dialog box.

Alt + H Click Help and then User Guide. Opens BroadWorks Receptionist User Guide.

Alt + L Click File and then Logout.
Logs out current user from Receptionist and returns 
to login screen.

9.3 SWITCHBOARD CONTROL KEYS

Key Strokes Equivalent Mouse Action Function

Ctrl + F1…F10
Click the Link column for a call on the 
Switchboard panel.

Displays the link symbol in the Link column for 
the call. F1 links the first call; F2 links the second 
call, and so on. Two calls must be selected for a 
successful link.

Shift + F1…F10 Click a call on the Switchboard panel.
Select the call. F1 selects the first call; F2 selects 
the second call, and so on.

9.4 CONTACT DIRECTORY CONTROL KEYS

Key Strokes Equivalent Mouse Action Function

Ctrl + F
Click the text entry space for keyword 
search.

Cursor appears in text entry space for entry of 
search keyword.

Ctrl + R Click on Reset.
Resets the search filter and shows the current 
directory.

Ctrl + Shift + <alpha>
Enter a single alphabetical character in 
the Search field and then select a filter 
from the search filter drop-down list.

Apply filter on sorted column.

Ctrl + UP/DOWN Select a filter from the Search filter. Traverses through the Search filter values.

UP/DOWN/RIGHT/
LEFT ARROW

Click each contact on the Contact panel 
in List view.

Selects the contacts on the list.

Page UP/DOWN Scroll through the contact list. Pages through the contacts on the list.
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9.5 OPTION CONTROL KEYS

Key Strokes Equivalent Mouse Action Function

<Number Pad /> Click Extension.
Selects the extension number of the selected 
contact.

<Number Pad *> Click Mobile. Selects the mobile number of the selected contact.

<Number Pad -> Click Voice Mail.
Selects the voice mail number of the selected 
contact.

<Number Pad 0,1…9> Click on Number Pad 0, 1,…9.
Enters the corresponding number in the dialing 
pad.

9.6 CONTROL KEYS

Key Strokes Equivalent Mouse Action Function

ENTER Click Dial. Dials the selected number.

<Number Pad +> Click Transfer. Transfers the selected call.

<Number Pad .> Click End. Ends the selected call.

Space Bar
Click Answer after selecting a call on the 
Switchboard panel, or double-click an 
incoming call on the Switchboard panel.

Answers the longest waiting incoming call. Multiple 
presses of the space bar answers the next call 
while placing the previous active call on hold.

F1…F10
Click Answer after selecting a call on the 
Switchboard panel, or double-click an 
active call on the Switchboard panel.

Sets a call to “Active” from “Ringing”. F1 applies to 
the first call listed on the Switchboard panel; F2 
applies to the second call, and so on.

F1…F10
Click Hold after selecting a call on the 
Switchboard panel, or double-click an 
active call on the Switchboard panel.

Sets a call to “On Hold” from “Active”. F1 applies 
to the first call listed on the Switchboard panel; F2 
applies to the second call, and so on.

F1…F10
Click Unhold after selecting a call on 
the Switchboard panel, or double-click a 
held call on the Switchboard panel.

Sets a call to “Active” from “On Hold”. F1 applies 
to the first call listed on the Switchboard panel; F2 
applies to the second call, and so on.

Shift + Ctrl + F1…F10 
OR

<Number Pad/Del>

Click a call on the Switchboard panel to 
select it and then click on End to end the 
call.

Ends the call. F1 ends the first call; F2 ends the 
second call, and so on.

<Number Pad +>
Click Blind Transfer/Consult Transfer/
Queue Transfer/Voice Mail Transfer

Blind Transfer/Consultative transfer/Queue transfer/
Voice Mail transfer to selected call or call option.

Ctrl +  
<Number Pad +>

Click Conference/Call Pickup/Barge-in.
Initiates a conference with linked call lines. 
Performs Pickup/Barge- in on selected contact.

Ctrl + Alt +  
<Number Pad +>

Click Conference Hold/Conference 
Unhold.

Toggles a conference from Held to Active state.

Ctrl + Shift +  
<Number Pad +>

Click End Conference.
Ends a conference. Releases all parties from the 
conference.

Ctrl + Alt + Shift + 
<Number Pad +>

Click Leave Conference.
Leaves a conference. Other parties remain 
connected.




